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Weemoed en toekomst

De vakantie zit er weer op. Althans, voor de 
meesten van ons. En dus wordt het met weemoed 
alle vakantiefoto’s bekijken en wegdromen 
bij alle mooie herinneringen aan plaatsen die 
bezocht zijn en dingen die gedaan zijn.  

Zo zijn wij dit jaar op een lange tocht naar 
Noorwegen en Zweden geweest, onze favoriete 
vakantielanden. In Bergen zien we de Tall Ship Race. 
Grote zeilschepen, waaronder de Kruzenstern, doen 
de havenplaats aan. Jonge rekruten leren hier met 
oude en moderne navigatiemiddelen en kaarten 
hun plaats te bepalen. Daarna het Sognefjord. 
Onvoorstelbaar dat de bergen naast het fjord 
tot 1700m boven zeeniveau uitsteken terwijl het 
diepste punt van het fjord op 1300m beneden 
zeeniveau ligt. Op weg naar Zweden gaan we 
naar de Jostedalsbreen en de Jotunheimen. We 
beklimmen de gletsjer: wat een geweldige ervaring 
en wat een geweldige schoonheid. Een lokale 
gids, waarmee we de gletsjer op gaan, vertelt ons 
dat dit jaar door de extreme warmte het ijs veel 
sneller smelt en zich terugtrekt dan andere jaren. 
We maken mooie kanotochten langs onbekende 
meren en riviertjes en we bezoeken verschillende 
musea bij cultureel en historisch erfgoed. Als 
we daarna afzakken naar het zuiden komen we 
uit in Haverud, waar het Dalslandkanaal via een 
ingewikkeld sluizen- en bruggen complex uit komt 
in het Vännern. Een spoorweg, een autoweg én 
een aquaduct kruisen elkaar hier op één plek. 

Als ik dit schrijf heb ik nog een paar dagen te gaan 
voor ik weer thuis ben. Ondertussen, al dit moois 
overdenkend, ben ik onwillekeurig toch alweer 
bezig met de vakantie van volgend jaar. Wat wil 
ik, met alle moois van dit jaar nog in gedachten, 
volgend jaar nog meer voor moois ontdekken.

Terug naar TMC. Na 18 jaar neemt Gerrit Jan 
Werler afscheid van het bestuur. Ook hij laat 
een fantastisch stuk historie na. Als nieuwe 
voorzitter denk ik alvast met veel plezier na over 
de toekomst van jullie en onze TMC Nederland.
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Scanopy, proud member of The People 
Group, heeft met de nieuwe release van 
GlobeSpotter Connector versie 3.0 voor Mi-
croStation, een soepele integratie mogelijk 
gemaakt binnen Bentley MicroStation, Bent-
ley Map en Bentley PowerCivil. CycloMedia’s 
beeldmateriaal kan direct worden ontsloten in 
de productieomgeving. 

Het is voor de gebruikers nog comfortabeler 
om diverse  informatiebronnen aan elkaar te 
koppelen en te visualiseren. Cyclorama-beel-
den kunnen worden gebruiken voor het verbe-
teren en accuraat inventariseren en uitwerken 
van bijvoorbeeld verkeersborden en lantaarn-
palen voor uw BGT-project. Daarnaast is de 
Connector een goede tool voor het (op af-
stand) inschatten van situaties, het bepalen van 
materiaalgebruik en vaststellen van erfgrenzen 
in het ontwerpproces voor diverse projecten in 
de openbare ruimte. Dit bespaart tijd en kan 
de gebruiker goed voorbereid het veld in.
De Provincie Overijssel gebruikt Bentley Micro-
Station in haar beheerprocessen en in de bouw 
van infrastructuur. Hierbij is het ontzettend 
handig dat met één druk op de knop (recente) 
foto’s van de situatie ter plaatse binnen onze 
productieomgeving beschikbaar te hebben.

Scanopy neemt de software Organize en 
Organize/NLCS van Para_Graph uit Haarlem 
over. Hiermee verstevigt Scanopy haar positie 
als softwareleverancier binnen de infrastruc-
turele wereld. Tevens is hiermee de continu-
iteit, ondersteuning en doorontwikkeling van 
Organize en Organize/NLCS gewaarborgd. 
Organize en Organize/NLCS is een applicatie 
waarmee snel, gemakkelijk en gestandaar-
diseerd getekend wordt in MicroStation en 
Bentley MAP. Scanopy neemt Organize en 
Organize/NLCS in zijn geheel over en zal de 
software onder dezelfde naam continueren. 
Voor Organize en Organize/NLCS betekent 
de overname meer mogelijkheden voor syner-

gie (slagkracht en innovatie) met The People 
Group en haar dochterondernemingen. Deze 
overname past in de strategie van The People 
Group om zich aanzienlijk te versterken in de 
Infrastructurele markt.

Kort nieuws
GLOBESPOTTER CONNECTOR VOOR MICROSTATION

BESTUUR TMC NEDERLAND
Het bestuur van TMC Nederland is 
veranderd. Paul Haffmans van Drie 
Linden heeft het voorzittersstokje 
van Gerrit Jan Werler overgeno-
men. Ook Erwin van Leiden van 
Syntrophos Spijkenisse komt het 
bestuur versterken. Beiden waren al 
betrokken bij TMC Nederland door 
hun actieve trekkersrol binnen de 
MicroStation- en Flexiweb/GWS-
focusgroep. 
Ze gaan samen met Nico van Caspel 
van gemeente Hoorn als secretaris 
en Dolf de Rooij van gemeente Am-
stelveen als penningmeester TMC 
Nederland vertegenwoordigen.

BENTLEY JAARVERSLAG 
2013 ONLINE
Het jaarverslag van Bentley Systems 
is onlangs verschenen. Het rapport 
presenteert de bedrijfsresultaten 
(met een duurzame omzetgroei van 
8%), de vooruitgang van BIM en 
commerciële innovaties. Het rap-
port is digitaal in te zien op www.
bentley.com/annualreport.

SOCIAL MEDIA TIP 
Bentley.general.nl is een Bentley 
community speciaal voor Neder-
landse gebruikers. In deze Bentley 
community zijn discussies, ideeën, 
tools en andere informatie in het 
Nederlands over Bentley-producten 
te vinden. Er hoeft niet ingelogd te 
worden om de Blogs, Forums en Fi-
les te bekijken.  

SCANOPY NEEMT ORGANIZE/NLCS OVER

Bentley organiseert wereldwijd LEARNing 
Conferences. Elke conferentie biedt gerichte 
trainingen in workshops en lezingen met 
actuele en praktische informatie. Dankzij deze 
conferenties kunnen deelnemers snel optimaal 
gebruik maken van hun Bentley software.  De 
opzet van de Bentley LEARNing Conferences 
sluit aan bij het nieuwe SELECT Open Access 

Quarterly Term Licensing 
programma “Software at your 
Service” van Bentley. Dankzij 
de netwerkmogelijkheden 
kunnen gebruikers contacten 
opbouwen met collega’s en 
discussiëren met specialisten, 

trainers en managers van Bentley. De 
deelnemers kunnen gerichte adviezen krijgen 
om hun vaardigheden en hun productiviteit te 
vergroten. Op 6 en 7 oktober is er een Geospatial 
& Utilities Conference en op 8 en 9 oktober een 
Plant & Building Conference in Mainz, Duitsland.  
Inschrijven is mogelijk via www.bentley.com/
LEARN2014.

BENTLEY LEARNING CONFERENTIES IN MAINZ
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Agenda
17-18 september 2014 Architect@Work

www.architectatwork.nl Ahoy Rotterdam

18 september 2014 NedGraphicsdag 2014 & BIM Congres
www.nedgraphics.nl  NBC Nieuwegein

2 oktober 2014 TMC Nederland Forum
www.tmc-nederland.nl Apenheul Apeldoorn

6-7 oktober 2014 GeoSpatial & Utilities Conference    
www.bentley.nl Mainz Duitsland

7 oktober 2014 Business Software Event 2014
www.business-software-event.nl Van der Valk, Eindhoven

7-9 oktober 2014 20th Intergeo
www.intergeo.de Berlijn, Duitsland

8-9 oktober 2014 Plant & Building Conference 
www.bentley.nl Mainz Duitsland

21-22 oktober 2014 Geo Utilities Europe 
www.geospatialutilities.com Londen, UK

4-6 november 2014 Year in Infrastructure 2014  
www.bentley.nl Londen, UK

19-20 november 2014 GeoBIM 2014
www.geo-bim.org/Europe Novotel Amsterdam

25-26 november 2014 GeoBuzz
www.geobuzz.nl Brabanthallen’s-Hertogenbosch
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In veel landen zijn er lokale gebruikersverenigingen. De één 
wat actiever dan de andere, maar het doel is overal hetzelfde. 
De gebruikers van Bentley-software bij elkaar brengen en in-
formeren over de laatste ontwikkelingen. Wereldwijd heten de 
gebruikersverenigingen The Bentley User Groups. “Wij zijn 
in Nederland wat eigenwijs, want wij noemen onszelf TMC 
Nederland, a Bentley User Group,” zegt Paul Haffmans. “De 
oorspronkelijke naam TMC is overal ingeburgerd, daarom 
laten we het zo.”

 Alle gebruikersverenigingen worden ondersteund door 
Bentley in Exton en vanuit de lokale kantoren. Financiële 
ondersteuning en sprekers voor bijeenkomsten en sponsorma-
terialen zijn daar voorbeelden van.

Actieve gebruikersvereniging

Ted Lamboo vertelt dat Nederland in vergelijking met veel 
andere landen wereldwijd een actieve gebruikersvereniging 
heeft. “Bijvoorbeeld Denemarken en Zweden zijn groter, 
maar Nederland organiseert veel. Wereldwijd een goede 
middenmoter. Jullie zijn overigens wel de enige met een 
eigen magazine.” Hij benadrukt het feit dat gebruikersver-
enigingen voor Bentley toegevoegde waarde hebben. Zeker 
op het gebied van communicatie is het belangrijk. “Jullie 
zijn onze klanten en hebben onderling contact met elkaar. 
Wij komen ook bij onze gebruikers over de vloer, maar jullie 
netwerk is groot. Wij zijn in de loop der jaren gegroeid van 
1 product naar ruim 300 producten en hebben wereldwijd 
veel klanten. “TMC Nederland vult in deze communicatie 
richting Bentley-gebruikers een belangrijke rol,” aldus de 
kersverse voorzitter. “Onze gebruikersvereniging is ingedeeld 
in zogenaamde focusgroepen met daarin actieve klanten 
uit de diverse vakgebieden. Zij weten als geen ander wat er 
speelt in de markt.” 

Bentley events

Bentley is sterk gegroeid en groeit nog steeds. Maar hoe 
bereiken ze, buiten de gebruikersverenigingen, hun klanten 
wereldwijd? Naast de lokale accountmanagers, nieuwsbrieven, 
en internetforums informeert Bentley haar gebruikers door 
de organisatie van evenementen en seminars. “Dit is een 
belangrijk onderdeel in onze communicatie met klanten,” zegt 
Lamboo. “Hier komen we met ze in contact en kunnen zij 
weer kennismaken met medewerkers van Bentley. Of dat nu 
CEO Greg Bentley is of een application engineer.” 

Een keer per jaar organiseren ze The Year of Infrastructure, 
waar projecten wereldwijd worden gepresenteerd. Prestigieuze 
projecten die op het gebied van Infrastructure design, Con-
struction of Operations Award Winnaar zijn. “Hier wordt het 
neusje van de zalm door de gebruikers en voor de gebruikers 
getoond, wat zeker ook interessant is voor Nederlandse 
klanten om te volgen,” aldus Lamboo. “Sterker nog, er zijn re-
gelmatig Nederlandse organisaties die genomineerd zijn. Het 
is heel nuttig voor iedere Bentley-gebruiker om te zien wat 
de innovatieve mogelijkheden zijn hoe de technologie wordt 
toegepast op projectniveau.”  The Year of Infrastructure wordt 
van 4 t/m 6 november in Londen georganiseerd, en heeft 
naast de visie presentatie van Bentley, veel externe sprekers en 
Industry Tracks. “Vanuit TMC Nederland zorgen wij er altijd 
voor dat we hierbij zijn, zodat wij het laatste nieuws kunnen 
communiceren richting onze leden,” zegt Haffmans. “Niet ie-
dere gebruiker in Nederland, zoals de wat kleinere gemeenten 
bijvoorbeeld, hebben de mogelijkheid hier naar toe te gaan.”

Een evenement waar de presentaties meer aansluiten op de 
lokale markt is het Bentley Advantage Seminar. Op 19 juni 
vond deze lokale Bentley bijeenkomst plaats in Media Plaza 
in Utrecht. Daar kwamen Nederlandse gebruikers aan het 
woord, lokale partners en Bentley-mensen. “Dit kun je het 

Samenwerking Bentley en TMC. Hoe vullen ze elkaar aan? 

Het bestuur van TMC Nederland is onlangs veran-
derd en de engineering/geo-markt is behoorlijk 
in ontwikkeling. Hoog tijd dus om een keer met 

leverancier Bentley om de tafel te zitten. MicroVisie 
Magazine was bij het gesprek aanwezig waar de 

nieuwe voorzitter van TMC Nederland Paul Haffmans 
en Senior Vice President Ted Lamboo bespraken 

hoe de twee organisaties elkaar kunnen aanvullen. 
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Samenwerking Bentley en TMC. Hoe vullen ze elkaar aan? 

beste omschrijven als een visie-evenement, waar gaat het naar 
toe in de markt. Een soort subset van het global nieuws. Inte-
ressant voor beslissers binnen een organisatie die willen weten 
wat de laatste ontwikkelingen zijn binnen hun vakgebied,” 
legt Lamboo uit. TMC Nederland was hier ook aanwezig om 
Bentley-gebruikers te informeren over alle mogelijkheden van 
de gebruikersvereniging. 

Knoppen

Om de diepgaande software gebruikers te bedienen zijn er 
de Learning Events met gespecialiseerde produkt trainingen 
die op verschillende plaatsen wereldwijd worden gehouden. 
Nederlandse gebruikers kunnen hiervoor naar Mainz in 
Duitsland waar op 6 oktober The Bentley Learning Con-
ference Geospatial and Utilities plaatsvindt. Op 8 oktober 
is hetzelfde event aan de beurt, maar dan op het gebied van 
Plant en Building. 

En last but not least organiseert Bentley regelmatig webinars 
die ingaan op een bepaalde toepassing, zoals Bentley Map. 
Vaak in verschillende talen waar ook Nederlands regelmatig 
voorbij komt. 

TMC Nederland richt zich met name op de technologie en 
de man of vrouw achter de knoppen wordt goed bediend tij-
dens de Focusgroepbijeenkomsten en het jaarlijkse TMC Fo-
rum. “Maar wij zijn ook een soort tussenlaag voor informatie 
vanuit het perspectief van gebruikers,” legt Haffmans uit. “We 
werken veel met lokale partners samen die weten wat er speelt 
en regelmatig onderwerpen voor bijeenkomsten aandragen.”

Wisselwerking

Waar zit nou het verschil tussen de evenementen van Bentley 
en TMC Nederland? “Er is zeker voor een deel overlap, want 
ook TMC kijkt naar de toekomst in de markt en de laatste 

Bentley-ontwikkelingen”, zegt voorzitter Haffmans. Volgens 
Ted Lamboo zit het verschil met name in het feit dat Bentley 
vooral vooruit kijkt en dat TMC zich meer richt op de tech-
nologie. “Bentley laat de aanwezigen voor 80% vooruit kijken 
naar wat er komt en 20% wat er al is. Bij TMC evenementen 
wordt er voor ongeveer een kwart naar de toekomst gekeken 
en 75% van de dag wordt besteed aan de technologie die er al 
is.”

Paul Haffmans sluit hierop aan. “Wij zijn geen ‘verkopers’ van 
Bentley, maar willen onze leden wel graag informeren over de 
laatste ontwikkelingen. Maar vooral het learning aspect vin-
den wij belangrijk. Daarom organiseren wij ook het komende 
Forum op 2 oktober weer veel hands-on workshops, waarbij 
aanwezigen tips en trucs krijgen om nog efficiënter met de 
software om te gaan.” 

Toekomst

Het moge duidelijk zijn, mobiliteit is een hot item. “Al jaren 
eigenlijk, maar langzaam dringt het nu door bij iedereen,” zegt 
Lamboo. “En BIM natuurlijk. Product Lifecycle Manage-
ment is heel goed toepasbaar voor ontwerp, bouw en beheer 
van intelligente infrastructuur.” 
Aan deze onderwerpen en meer wordt uiteraard aandacht 
besteed op het TMC Forum en in Mainz tijdens de Learning 
Events van Bentley. 

De toekomst van de samenwerking tussen Bentley en TMC 
Nederland ziet er ook goed uit. Op praktisch gebied kan 
de gebruikersvereniging rekenen op ondersteuning van de 
leverancier en hoopt dat ook de financiële bijdragen gegaran-
deerd blijven. “De communicatielijnen zijn kort, waardoor we 
beiden de Nederlandse Bentley-gebruikers zo optimaal moge-
lijk kunnen informeren. Samen detecteren we wat er speelt en 
pakken dat gezamenlijk op,” sluit Ted Lamboo af. 

7

Door: Ilse Zethof, TriCentric Communicatie
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Samen aan de lat en in regie voor de opbouw van de BGT!
De gemeenten Dantumadiel, Dongeradeel, 

Ferwerderadiel en Kollumerland c.a. hebben 

gezamenlijk een project gedefinieerd met 

als belangrijkste doelstelling de opbouw en 

implementatie van de BGT in nauwe samenhang 

met de verbetering van de informatievoorziening 

rondom het beheer van de openbare ruimte 

en overige ruimtelijk georiënteerde processen. 

In gesprek met Evert Tuinstra, projectleider 

van het deelproject Opbouw BGT, valt vooral 

het enthousiasme, de visie, betrokkenheid en 

vastberadenheid op. Eigenschappen die nodig zijn 

om een dergelijk project tot een succes te maken 

en de ideale gesprekspartner om u een kijkje te 

geven in het proces dat de vier gemeenten in 

Noordoost Fryslân met elkaar (hebben) doorlopen. 

Kwaliteit en regie

Geconfronteerd met de wetgeving rondom de BGT, constateerden 
de afzonderlijke gemeenten al snel dat zij te klein waren om de 
BGT zelf op te bouwen en te beheren. Een constatering die ove-
rigens gepaard ging met het besef dat de gemeenten wel degelijk 
de regie in eigen hand wilden houden en de kwaliteit en actua-
liteit van de brondata als succesfactoren werden gezien voor een 
geslaagde opbouw van de BGT. Om de kwaliteit van de brondata 
te beoordelen heeft een analyse plaatsgevonden die heeft geleid tot 
een aantal verbeterslagen. Zo is het buitengebied verder opgewerkt 
en zijn waterlopen die eerder niet volledig gekarteerd waren, in 
kaart gebracht. Uiteraard heeft het opwerken van het buitengebied 
“BGT voorbereid” plaatsgevonden door direct kenmerkpunten 
te plaatsen, vlakafsluitingen mee te nemen en ook Elzensingels, 
karakteristiek voor het Friese landschap, te karteren. 

Om alles zoveel mogelijk in eigen hand te houden, is onder 
het motto “zelf doen wat we kunnen en uitbesteden wat moet” 
een gezamenlijk opbouwteam opgezet. Dit opbouwteam met 
vertegenwoordiging vanuit alle vier gemeenten werkt op basis van 
MicroStation/GEOCAD in combinatie met NGdW, geleverd en 
geïmplementeerd door NedGraphics, aan de opbouw van de BGT. 
Evert Tuinstra roemt hierbij het commitment van het opbouw-
team. Sommige medewerkers van het opbouwteam hebben zich in 

De projectkamer waar iedere gemeente aan een eigen dataset werkt
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w
korte tijd het werken met een ander CAD-pakket eigen gemaakt. Daar-
naast is het het opbouwteam zelf geweest, dat, doordrongen van de voor-
delen, de bereidheid heeft getoond om drie dagen per week gezamenlijk 
op één locatie te werken aan de opbouw van de BGT. Hierdoor is een 
platform ontstaan voor optimale kennisuitwisseling. In het gemeentehuis 
van Kollumerland is een projectkamer ingericht waarin iedere gemeente 
vanaf een eigen werkplek werkt aan de eigen dataset. Er wordt dus nog 
gewerkt met vier datasets, maar gebruik gemaakt van één regelgeving en 
één presentatietabel. Dit levert niet alleen efficiencyvoordelen op bij het 
inregelen, maar biedt tevens uniformiteit bij de inrichting. 

Aanpak en fasering

Met de basis op orde en de infrastructuur naar wens kon de opbouw van 
de BGT beginnen. Met maar liefst 62 dorpen en in totaal ruim 600 vier-
kante kilometer grondoppervlak, waarvan 431 vierkante kilometer voor 
rekening van de gemeenten, was het van belang om een goede werkwijze 
en fasering te kiezen. Na diverse mogelijkheden te hebben bekeken, heb-
ben de vier gemeenten gekozen voor een themagewijze opbouw. Met de 
opgewerkte GBK-kaart als basis en alleen de objecten water op de kaart, 
blijft er een kleine set lijnelementen over die een duidelijk beeld geeft 
van het gebied. Waterlopen bepalen in Friesland tenslotte voor een groot 
deel hoe het gebied eruit ziet. 

Vervolgens is ervoor gekozen om te werken met een zogenaamde “knip” 
kaart van 1 km bij 1 km. Door deze aanpak kan op één dag een gebied 
van een vierkante kilometer worden uitgecheckt vanuit de database naar 
de werkomgeving en vervolgens BGT proof weer worden ingecheckt 
in de database. Op deze vierkante kilometer zijn dan de erven gevormd, 
de begrenzing van EZ meegenomen, de verharde boerenpaden over het 
eigen weiland opgenomen en de classificaties aangebracht. De openbare 
ruimte wordt in deze fase nog niet opgenomen. Op deze manier werken 
de vier gemeenten vlak voor vlak aan het buitengebied en kijken daarbij 
zorgvuldig naar het bronhouderschap. De gemeenten hebben in die zin 
ook de regie naar zich toegetrokken als het gaat om de opbouw en as-
semblage voor het ministerie van EZ en Wetterskip Fryslân. 

Als het buitengebied, zo’n 93% van het op te bouwen oppervlak, volledig 
is ingevuld, zal de openbare ruimte strooksgewijs worden gevuld. Dit 
geldt ook voor de dorpen. Door te kiezen voor de vlaksgewijze aanpak 
ontstaat:

•  overzichtelijkheid;
•  aan het einde van de dag kan het gebied worden ingecheckt en ziet 
men gelijk het resultaat en een goed gesloten kaart;
•  er ontstaat voor de gebruikers meer interactie met het eindproduct;
•  het is makkelijker om bij te sturen.
Tot slot wordt de pandgeometrie, nu ook al opgeslagen in NGdW, 
aan de kaart toegevoegd.

Uiteindelijk zullen ook de BAG en BOR geometrie in de BGT worden 
bijgehouden.

Missie geslaagd!

Op mijn vraag wanneer zijn missie geslaagd is, geeft Tuinstra aan: “Als 
er na de zomer van 2015 een volledige beheersorganisatie staat die het 
beheer heeft over een goede, maar vooral ook actuele BGT-kaart en de 
vier gemeenten op een goede wijze data met elkaar uitwisselen, ook op 
het gebied van de BAG en het BOR.”

9

Samen aan de lat en in regie voor de opbouw van de BGT!

Door: Joyce Versteeg, NedGraphics

Opwerkbestand BGT Gemeente Kollumerland
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Altijd actuele RO-informatie
De dynamiek van onze samenleving raakt ieders informatievoorziening op het gebied van ruimtelijke ordening. 

Een gemeente wil immers dat medewerkers en burgers altijd en overal over actuele en correcte informatie kun-

nen beschikken. De dynamiek zorgt echter voor een continue stroom van wijzigingen. Daardoor ontstaat een 

stapeling van procedures en plannen en dreigen medewerkers en burgers al gauw het overzicht te verliezen.

Orde in de chaos

Crotec biedt een oplossing die de veelheid aan plannen (met 
vaak aanzienlijke overlap) terugbrengt tot een overzichtelijk 
beeld voor het gehele plangebied. Deze oplossing - RoCon-
solideer -  combineert onherroepelijke bestemmingsplan-
nen (imro2008/2012) in een geconsolideerd beleidsthema 
binnen een ruimtelijke database. Administratieve data 
(regels, toelichtingen etc) blijven direct vanuit de bron 
raadpleegbaar. Overlappende objecten of objectdelen worden 
uitgeknipt en als historie binnen de database bewaard.

Procedurelagen

De wettelijke kaders vertroebelen het overzicht. Plan-
nen, herzieningen, gerechtelijke uitspraken kunnen 
op een locatie in beeld komen. RoConsolideer biedt 
de mogelijkheid om beleid te scheiden door ge-
laagdheid op basis van de volgende procedures:  

•  Onherroepelijke plannen (ineen gesneden)
Aan de hand van de planstatus en de dossierstatus 
wordt bepaald of een plan onherroepelijk is. Als on-
herroepelijke herkenbare plannen worden ineen ge-
sneden tot een gemeente dekkende beleidslaag. 
•  Plannen waartegen beroep loopt
Vastgestelde plannen waarvan de dossierstatus aangeeft 
dat er een beroep is ingesteld worden in deze laag getoond.
•  Vastgestelde plannen
RoConsolideer biedt vastgestelde plan-
nen in een separate laag aan. 
•  Plannen in ontwikkeling
Plannen met een status eerder dan vast-
gesteld komen in een separate laag.

Omgevingswet

De nieuwe omgevingswet ligt voor advies bij de Raad 
van State. Daarna wordt deze wet behandeld in de ka-
mer. Hoewel nog niet duidelijk is wat dit betekent voor 
de huidige instrumenten, is al wel helder dat een omge-
vingsplan een gemeente dekkende objectgerichte oplos-
sing gaat worden. RoConsolideer kan worden gezien 
als een opmaat voor het nieuwe omgevingsplan.

Open toepassing

RoConsolideer is een open toepassing: ze past niet alleen 
naadloos in het Crotec-RoTotaal-concept maar werkt net 
zo goed binnen andere gestandaardiseerde raadpleegomge-
vingen. Daartoe werkt RoConsolideer met een Web Map 
Service (WMS) en een Web Feature Service (WFS). WMS 
bepaalt de opbouw en presentatie van de uiteindelijke ge-
consolideerde plankaart. Ieder objecttype (enkelbestemming, 
dubbelbestemming, gebiedsaanduiding) is als aparte laag 
opgenomen. WFS zorgt ervoor dat geografische vectordata 
en bijbehorende 
administra-
tieve data recht-
streeks vanuit 
de betreffende 
bronnen kun-
nen worden 
opgevraagd. 
De oplossing sluit dus prima aan bij de doelstellingen 
van de Andere Overheid. Bovendien is het mogelijk 
om direct (lees)toegang te krijgen tot de database.

Transparant en betrouwbaar

Crotec biedt RoConsolideer als Software as a Ser-
vice. Dat bespaart lokale installaties en beheeractivi-
teiten. Het is een volledig transparante oplossing die 
van  de opdrachtgever geen extra werkzaamheden vergt 
dan reeds voorzien vanuit de gangbare praktijk. 
Als bron voor RoConsolideer gelden de weblocaties van de 
gemeente, provincie en het Rijk. RoConsolideer verwerkt 
geheel automatisch als onherroepelijke gepubliceerde plan-
nen in een geconsolideerd beleidsthema. De service ontzorgt 
de gemeentelijke organisatie volledig bij het transparant 
en betrouwbaar ontsluiten van de grote verscheiden-
heid aan planinformatie die u als bronhouder beheert.

Proefviewer

RoConsolideer bouwt automatisch een database op van 
plannen. Het is geen 
viewer, maar een infor-
matiebron.  De data kan 
in een eigen viewer of 
GIS omgeving worden 
ontsloten. Voor evalu-
atiedoeleinden biedt 
Crotec een eenvoudige 
proefviewer aan waarin de verschillende (WMS)planla-
gen al-dan-niet in combinatie kunnen worden getoond.

Door: René Kleij, Crotec
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Sponsors

Het TMC Forum 2014 wordt gesponsord door:

Het thema

Het thema dit jaar is ‘In de aap gelogeerd!?
Chimpansees verschillen maar 1,4% in genetisch opzicht van 
de mens en hebben net zoals wij een lange kindertijd waarin 
ze basale vaardigheden moeten leren. Maar kunnen we ook 
iets leren van deze apen? Gaan we innoveren of na-apen?

Keynotes  

De dag wordt begonnen met keynote-sessies, waarbij uiter-
aard uitgebreid wordt ingegaan op het thema van de dag. 
Onze keynote-sprekers van dit jaar zijn GIS-pionier Prof. Dr. 
Henk Scholten en Constanze Mager van ApeManagement, 
die een leuke presentatie geeft met als titel ‘Apenstreken, in-
noveren of na-apen’. 

Breakouts

Tijdens de breakout-sessies komen alle vakgebieden aan de 
orde en zijn er sessies voor gebruikers en beslissers. Bentley 
Institute geeft u de mogelijkheid om aan verschillende hands-
on sessies deel te nemen. 
Uiteraard willen we u ook de kans geven om iets van het park 
te zien en daarvoor zijn de speciale buitenworkshops/rondlei-

dingen. Deze rondleiding is als parallel sessie in uw dagpro-
gramma in te plannen.

Lunch en borrel 

Tijdens de pauzes krijgt u voldoende gelegenheid om met 
elkaar bij te praten, te netwerken en de stands te bezoeken. 
Wij nodigen u na alle presentaties graag uit voor de gezellige 
borrel met hapjes, aangeboden door onze sponsors. Traditie-
getrouw zullen prijzen verloot worden onder de aanwezigen. 
Zeker de moeite waard om te blijven!.  

Kosten

Zoals altijd is de toegang voor TMC-leden gratis. Niet leden 
zijn uiteraard ook van harte welkom, maar tegen een bijdrage 
van € 100,-. 

Inschrijving en toegang

Aanmelden kan online via www.tmc-nederland.nl of stuur 
een mail naar: forum2014@tmc-nederland.nl met uw gege-
vens en welke sessies u bij wilt wonen.
Wij verzoeken u vriendelijk per persoon in te schrijven en 
gelieve voor vrijdag 26 september a.s. 

09.00– 10.00 Ontvangst en registratie

10.00– 12.15 Opening en keynotes

12.15 - 13.15 Lunch

13.15 -14.15 AutoPLANT Open-Roads BGT Leiden WS: ProjectWise WS: 3D Camera’s Buitenworkshop

14.20 - 15.20 Workflow 
Rules Engine

RoPlan Information 
Mobility

WS: van 2D 
naar 3D AHN2

WS: AECOSIM Buitenworkshop

15.20 - 15.40 Koffiepauze

15.40 - 16.40 BIM bij 
gemeenten

Bentley Map 
en BGT

ProjectWise Bentley Rail WS: Micro-
Station

Buitenworkshop

16:40 - 19:00 Verloting en borrel met uitgebreide borrelgarnituur

TMC Nederland Forum 
2 oktober 2014

Apenheul Apeldoorn

‘In de aap gelogeerd!?’ 
TMC Nederland nodigt u graag uit gast te zijn op het jaarlijkse Forum.

Net als andere jaren wordt het een informatieve dag voor gebruikers 
van Bentley-software, maar zeker ook voor managers. Er is aandacht 
voor MicroStation, ProjectWise, 3D, Geo, Rail, RoPlan, BIM, Architec-
ture, Civiel en Plant. Een evenement met keynotes, presentaties, work-
shops en een informatiemarkt. Informatie vergaren, kennis delen en 
netwerken. Het kan allemaal 2 oktober!
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AutoPLANT Modeler SS6 met de nieuwe 
OpenPlant Isometric output
Door: Rudy Coupé, Sr. Application Engineer Bentley Plant

Een Piping Isometric is één van de belangrijkste op te le-
veren documenten vanuit het Plant design model. Sinds 
AutoPLANT Modeler V8i SS5 gebruiken we de Bentley 
technologie voor het produceren van de Isometrics.  
Bentley OpenPlant Isometric Manager V8i (OPIM) maakt 
Isometrics aan vanuit verschillende bronnen, zoals Open-
Plant Modeler, AutoPLANT en vanuit een i-model of iRING 
compatibel 3D-model.
Tijdens deze presentatie geven we aandacht aan Auto-
PLANT Modeler met OPIM. We behandelen de workflow 
en tonen configuratiemogelijkheden. Hierbij wordt gede-
monstreerd dat OPIM een waardige vervanger is van de 
vorige Isometrics tool met een zeer flexibele grafische in-
terface en tal van configuratie opties.  
___________________________________________________

OpenRoads Update
Door:  Ernst van Baar, Application Engineer Bentley en Ian Rosam, 

Product Manager Bentley

In deze presentatie, die gedeeltelijk in het Engels gege-
ven wordt, zal worden ingegaan op twee onderwerpen:
- Wat brengt OpenRoads technologie voor transporta-

tion en urban infrastructure planning en construction. 
- OpenRoads ontwikkelingen
___________________________________________________

BGT koploper Leiden; 
van visie naar realisatie
Door: Pascal Keij, gemeente Leiden

Leiden was in 2008 “in de aap gelogeerd”. Met een 
verouderde GBKN-kaart die niet of slecht werd gebruikt 
in tientallen afnemende applicaties kwam de afdeling 
GEO-informatie geen stap verder. In 2009 werden ze 
wakker geschud. Leiden ontwikkelde een nieuwe visie 
op het beheer van de openbare ruimte waarin GEO-
informatie een belangrijke rol speelt. De veranderingen 
werden door medewerkers vertaald naar goede concrete 
ideeën en gerealiseerd. In deze periode veranderen ze 
van leveranciers en kochten een nieuw beheersysteem 
voor de BOR-afdeling. Ook kwam er een nieuw centraal 
gegevensmagazijn. De aanpak heeft gewerkt en geleid tot 
een succesvolle overgang naar een integrale benadering 
van Geo-informatie. In de sessie deelt Leiden zijn visie 
en geeft tips om te komen tot een succesvolle BGT-
implementatie. 

Bentley Map – BGT
Door: Marc Rietman, Bentley Systems

Bentley Map voegt GIS-functionaliteit toe aan uw ver-
trouwde MicroStation. In deze sessie wordt functionaliteit 
behandeld die gebruikt kan worden voor de opbouw van 
BGT. Maar het kan ook voor andere toepassingen handig 
zijn, zoals het ontsluiten van beheerdata. Voorbeelden 
zijn: ontsluiten van WFS en Oracle data, Import Shape, 
gdb en importeren via FME plugin, structureren van data 
en vlakvorming.
Regelmatig komt de vraag hoe het mogelijk is om attri-
buten van beheerdata over te nemen naar zojuist aange-
maakte vlakken. Aan de hand van een voorbeeld wordt 
dit getoond.
__________________________________________________

Een visie op BIM bij gemeenten
Door:  Kees van der Lee, Algemeen directeur only BIM

Steeds meer bedrijven in de bouwsector zien de voorde-
len van het werken volgens een BIM (Bouwwerk Informatie 
Model). Pro-rail, RWS en de Rijksgebouwendienst hebben 
zich gecommitteerd aan BIM. Enkele gemeente schrijven 
BIM al voor bij vastgoedontwikkelingen. In deze presen-
tatie nemen wij u mee in de wereld van BIM en geven wij 
onze visie op BIM bij gemeenten. De voordelen van het 
gebruik van BIM in diverse bedrijfsprocessen komen hier-
bij aan de orde. 
__________________________________________________

Bentley Rail Update 
Door: Ian Rosam, Product Manager Bentley Systems

Deze presentatie wordt gegeven in het Engels. Waar staat 
Bentley nu met de Bentley Rail producten en welke ont-
wikkelingen worden er verwacht.
__________________________________________________

ProjectWise en de mobiele wereld
Door:  Johan Vreede, Studio 4D en Hans Koorneef, Bentley 

Systems

Het gebruik van ProjectWise in de mobiele wereld krijgt 
steeds meer aandacht. In deze sessie wordt uit de doeken 
gedaan wat er zoal kan en welke acties men moet onder-
nemen om het gebruik ervan te ondersteunen.
Daarbij komen onderwerpen als i-models, ICS (i-model 
composition server) en de Supervisor App aan de orde en 
zal een roadmap voor het gebruik van i-models en pdf in 
ProjectWise uit de doeken gedaan worden.

Programma breakout-sessies

TMC Nederland Forum 
2 oktober 2014 in de Apenheul Apeldoorn
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Workflow Rules Engine, mogelijkheden 
en praktische toepassing bij gemeente 
’s-Hertogenbosch
Door: Paul Migchielsen, gemeente ’s-Hertogenbosch en Hans 

Koorneef, Bentley Systems

In deze sessie wordt ingegaan op de mogelijkheden van 
deze recent geïntroduceerde verbeterde workflow afhan-
deling waarbij het mogelijk is om aan de ene kant veel 
meer te kunnen sturen en toch aan de andere kant gebrui-
kersvriendelijk te kunnen zijn. En dat alles met als basis 
een gewone Excel spreadsheet! Na de theoretische be-
handeling zal de gemeente ’s-Hertogenbosch laten zien 
hoe deze nieuwe mogelijkheden in de praktijk worden 
ingezet. 
__________________________________________________

RoPlan, een update
Door: Rene Kleij en André Sluyter, Crotec

Tijdens deze RoPlan sessie wordt u bijgepraat over de 
onderwerpen RoPlan en RoTotaal 3.0, Welstandsplannen 
(IMWE) en De Omgevingswet komt eraan.
__________________________________________________

Information mobility brengt vele 
mogelijkheden voor uw ontwerpteam 
Door: Ernst Van Baar & Marc Rietman, Application Engineers 

Bentley Systems

Als we het over information mobility hebben, dan zullen 
de meeste mensen aan smartphones en tablets denken. 
Het gaat ook over mobiele technologie, maar voor een 
moderne organisatie betekent information mobility veel 
meer dan dat. In deze sessie laten we de mogelijkheden 
zien om data te publiceren en te gebruiken. Zowel op ta-
blets als op desktop applicaties.
__________________________________________________

Workshop Van 2D naar 3D met AHN2
Door: Mark C. Bos, consultant Ballesta

In deze workshop gaan we in op het gebruik van beschik-
bare 3D-data van de AHN2 om van een 2D-ontwerp een 
3D-ontwerp te maken.

Workshop Camera’s en camera animaties
Door: Mark Stals, gemeente Eindhoven en Louis Paul van 

Amerongen, Witteveen+Bos

Tijdens de workshop worden de volgende onderwerpen 
interactief behandeld:
Het plaatsen en interactief verplaatsen van een camera en 
het wijzigen van camera-instellingen. We gaan ook een 
camera door een 3D-model laten vliegen met verschil-
lende kijkpunten en hier filmpje van maken. 
__________________________________________________

Workshop Introductie AECOsim 
Building designer architectural op lokale 
Nederlandstalige dataset
Door: Ronny Verbruggen, 4D Select 

        
Maak kennis met AECOsim Building Designer Architec-
tural met een Nederlandstalige dataset. Ondek de 3D 
mogelijkheden door het plaatsen van fundering, muren, 
deuren en ramen, trappen, sanitair …
Maak rapporten, doorsnedes en plaats deze op een sheet 
om af te drukken.
__________________________________________________

Workshop ProjectWise
Door: Johan Vreede, Studio 4D en Ian Emery, Dockwise

Met behulp van een korte hands-on training kunnen deel-
nemers kennismaken met het gebruik van ProjectWise en 
enkele belangrijke mogelijkheden. Ook de samenwerking 
met mobile devices wordt kort uitgelegd. Voorkennis is 
niet vereist, maar enige bekendheid met MicroStation is 
aan te bevelen.
__________________________________________________

Workshop MicroStation
Door: Paul Haffmans

Het onderwerp van deze workshop wordt later bekend 
gemaakt. Hou www.tmc-nederland.nl in de gaten.
__________________________________________________

Buitenworkshop/rondleiding
Apenstreken: Survival of the fittest
door: Apemanagement

Apen werken en leven samen in zeer verschillende sociale 
structuren. Wat betekenen deze verschillen in de sociale 
structuren voor een organisatie? Apen hebben hun struc-
tuur optimaal aangepast aan de omgeving waar zij moe-
ten overleven. Maar hoe passen wij ons aan bij ontwikke-
lingen in onze omgeving? Tijdens deze buitenworkshop 
ontdekt u wat het betekent om optimaal aan te passen 
aan een veranderende omgeving en wat u moet doen als 
onze oerinstincten ons daarbij hinderen. 

Programma breakout-sessies
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SELECT Open Access – “Software at your Service”!

Voordat dit gedaan wordt, is het goed 
eerst even stil te staan bij de ontwerp-
filosofie van de Bentley licentieserver, 
SELECTserver.

Het principe achter SELECTserver is 
dat gebruikers altijd gebruik kunnen 
maken van Bentley-oplossingen. Om 
dit principe te kunnen waarborgen 
moeten er keuzes gemaakt worden. Hier 
volgt een korte opsomming:

1.  SELECTserver kent geen ‘heart-
beat’ mechanisme – als een licentie-
server het gebruik van licenties moet 
kunnen beperken, is er een real-time 
connectie nodig tussen het werk-
station dat de software draait en de 
licentieserver. Mocht zo’n real-time 
connectie onverhoopt uitvallen, stopt 
de software – een situatie die door 
veel gebruikers als niet wenselijk 
wordt gezien;

2.  Zeker als er gebruik gemaakt 
wordt van een externe licentieserver – 
wat op zich vele voordelen heeft – zal 
het Internet gebruikt worden om de 
connectie tussen werkstation en de 
licentieserver tot stand te brengen. 
De betrouwbaarheid van het Internet 
is groot, maar 100% ‘uptime’ bestaat 
niet. En dus kan een real-time con-
nectie naar een licentieserver falen. 
Wederom met gevolg dat de software 

op een werkstation niet langer te 
gebruiken is;

3.  In situaties waar de licentieserver 
lokaal staat is er een netwerkcon-
nectie nodig tussen werkstation en 
licentieserver. Ook deze connectie 
kan geen 100% ‘uptime’ garanderen – 
met identieke gevolgen als beschreven 
in punt 2.

Trust Licensing – gebruik waar en 
wanneer

Meestal zullen storingen in de connectie 
tussen werkstations en licentieserver 
optreden op ongewenste momenten. 
Veel klanten vroegen Bentley om ten alle 
tijden hun productie-uren voor te laten 
gaan en Bentley weet dat hun software 
voor professioneel gebruik ingezet wordt 
en dus is er, jaren geleden, voor het ‘trust 
licensing’ principe gekozen. De produc-
ten zijn te gebruiken waar en wanneer 
ze nodig zijn en het wordt niet beperkt 
door plafonds vastgelegd in een contract. 
De ervaring is dat deze methodiek door 
het merendeel van de gebruikers gewaar-
deerd wordt en dus zijn er geen plannen 
dit te wijzigen. Als een gevolg hiervan is 
een belangrijke rol van SELECTserver 
het rapporteren over gebruik en niet het 
tegengaan van gebruik! En – zonder 
‘heartbeat’ mechanisme – is het ook niet 
mogelijk toegang tot licenties te contro-
leren en te beperken.

De beschreven methodiek is reeds vele 
jaren, tot tevredenheid van Bentley en 
haar klanten, in gebruik. SELECT Ba-
sic- of Open Access verandert niets aan 
de werkwijze van SELECTserver.

Wat is ‘meer gebruik’?

Het enige dat verandert is de wijze 
waarop u belast wordt voor meer 
gebruik. Wat is ‘meer gebruik’? Wel-
licht het eenvoudigst te verklaren aan 
de hand van een voorbeeld: stel in uw 
contract met ons staat dat u recht heeft 
op het gebruik van vijf MicroStation 
licenties. Meestal is dit toereikend. U 
bent echter in een kritieke fase van een 
groot contract en u heeft een paar we-
ken zeven MicroStation licenties nodig. 
Met SELECTserver kan dit. 

Uiteraard willen wij wel gecompen-
seerd worden voor dit ‘meer gebruik’. 
Tot de komst van SELECT Basic- of 
Open Access was het alleen moge-
lijk extra licenties aan te schaffen. 
Een uitstekende oplossing – ook bij 
SELECT Basic- of Open Access – als 
dit ‘meer gebruik’ structureel is, een 
dure oplossing als u de genoemde twee 
extra licenties maar vier weken per jaar 
nodig heeft!

Zowel SELECT Basic Access als 
SELECT Open Access lossen dit op. U 
wordt – per kwartaal – belast voor ‘meer 

In het begin van 2014 heeft Bentley het 

SELECT Open Access programma ge-

introduceerd, hetgeen veranderingen 

met zich mee brengt voor alle wereld-

wijde SELECT-gebruikers.  Dit artikel 

beschrijft de details van SELECT Basic 

Access en SELECT Open Access.
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SELECT Open Access – “Software at your Service”!

gebruik’ maar betaalt alleen voor het afgelopen kwartaal.  
Als u de extra licenties niet (meer) nodig heeft, betaalt u 
dus ook niets!

Verschil tussen SELECT Basic Access en SELECT Open 
Access

SELECT Basic Access stelt u in staat ‘meer gebruik’ te heb-
ben van Bentley-producten die u aangeschaft heeft. Weer 
een voorbeeld: als u MicroStation en Bentley Map gekocht 
heeft, kunt u dus meer licenties van deze twee producten 
gebruiken. U kunt echter geen gebruik maken van Po-
werCivil for Country. De kosten van meer gebruik onder 
SELECT Basic Access bedragen (per licentie, per kwartaal) 
16% van de dan geldende lijstprijs van de licentie die meer 
gebruikt wordt.

SELECT Open Access stelt de gebruiker in staat ‘meer 
gebruik’ te hebben van alle Bentley producten. Weer een 
voorbeeld: als MicroStation en Bentley Map gekocht zijn, 
kunnen er dus meer licenties van deze twee producten 
gebruikt worden. De klant kan echter ook gebruik maken 
van PowerCivil for Country, zonder dat dit ooit aangeschaft 
is. De kosten van meer gebruik onder SELECT Open 
Access bedragen (per licentie, per kwartaal) 14% van de dan 
geldende lijstprijs van de licentie die meer gebruikt wordt.

SELECT Basic- en Open Access zijn de volgende stappen 
naar een ‘pay for usage’ model. ‘Pay for usage’ heeft de toe-
komst! Natuurlijk betekent ‘pay for usage’ dat u het gebruik 
moet monitoren. Niets nieuws, ook onder het ‘trust licensing’ 
model moest dit. Het is ook niet uniek – veel software 
oplossingen kennen verrekenmethoden die gelijk zijn aan 
SELECT Basic- en Open Access.

Genoemde prijzen en percentages in dit artikel zijn vrijblijvend.

Tekst: Bentley Benelux
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“Een jaar of vijf geleden hoorde ik voor het eerst van de 
NLCS als nieuwe tekenstandaard”, vertelt Maarten van 
Ameijde, hoofd van de ontwerpafdeling binnen Van der Waal 
& Partners. “In MicroStation werken wij als ingenieursbureau 
voor overheden, projectontwikkelaars, aannemers en particu-
liere partijen. Vaak heeft iedere opdrachtgever zijn eigen teken-
standaard ontwikkeld met specifieke eisen en tekenrichtlijnen. 
De één in MicroStation, de ander weer in AutoCAD. En dat 
botste nog weleens met onze eigen tekenrichtlijnen waarmee 
alle medewerkers op onze ontwerpafdeling kunnen tekenen, 
lezen en schrijven.” Met het idee achter de NLCS is dan ook 
helemaal niks mis, beaamt ook Van Ameijde. “Als je zag hoe-
veel tijd door ons besteed werd aan het bestuderen of omzetten 
van tekeningen van derden; hier viel een hoop te verbeteren!”

Sceptisch

 “Toch was ik in het begin redelijk sceptisch over de meer-
waarde van de NLCS. Is het ook echt nodig? Gaat dit wel 
werken binnen onze sector?” Ook bij de ontwerpers en pro-
jectleiders voelde Van Ameijde de nodige terughoudendheid 
over een eventuele overstap. “Men was vooral bang dat met 
het vervallen van de ‘eigen’ tekenrichtlijnen ook de huisstijl 
zou komen te vervallen en daarmee de herkenbaarheid van 
ons product.” Erik van der Aart, projectleider Infra binnen 
Van der Waal & Partners valt Van Ameijde bij: “We besteden 
de nodige aandacht en zorg aan onze producten. Het mooiste 
is als een opdrachtgever of aannemer een tekening openvouwt 
en direct, in positieve zin, herkent dat het een ontwerp van 
Van der Waal & Partners is. Dan weet je dat je als bedrijf iets 
te bieden hebt, een uniek signatuur. Met de komst van de 
NLCS zou dit mogelijk allemaal wegvallen. Terecht of onte-
recht, dat gevoel leefde sterk binnen de organisatie.”

Toch kwam er ook binnen Van der Waal & Partners een 
omslag. Van der Aart: “We merkten duidelijk een toenemende 
vraag vanuit de markt. Steeds meer van onze opdrachtgevers, 
niet alleen de grote partijen, namen de NLCS tekenstandaard 
op in offerteaanvragen. Voor ons was dat het signaal om de 
volgende stap te zetten.” In het voortraject had Van Ameijde 
al de mogelijkheden verkend. Naast het financiële plaatje 
(aanschaf én onderhoud) werd er vooral ook gekeken naar de 
mogelijkheden en de invloed van verschillende applicaties op 
de huidige manier van werken binnen het bedrijf. Van Ame-
ijde: “Op basis van deze factoren kwamen we uit bij Organize 
NLCS van Para_Graph, tegenwoordig Scanopy.” 

Afdelingsbrede implementatie

In eerste instantie is Van der Waal & Partners aan de slag 
gegaan met één licentie. Met een aantal kerngebruikers is een 
project opgestart en vervolgens van A tot Z doorlopen. Van 
Ameijde: “Gelukkig kwam onze eigen structuur al redelijk 
overeen met de nieuwe structuur van de NLCS. Dat maakte 
de overgang voor onze medewerkers niet al te groot.” On-
danks dat waren er natuurlijk wel opstartproblemen, beaamt 
hij. “Een jarenlange werkwijze zet je natuurlijk niet van de 
één op de andere dag overboord.” De kerngebruikers ervoeren 
echter ook het gemak van Organize NLCS in het enorme 
woud van lagen, stijlen en kleuren. Alle bevindingen die in dit 
stadium zijn opgedaan, zijn vervolgens breed gecommuniceerd 
binnen de ontwerpafdeling. Al snel daarna is doorgepakt en is 
de implementatie afdelingsbreed ingezet.
Van Ameijde vervolgt: “Over de samenwerking met zowel 
Para_Graph als Scanopy ben ik zeer positief. Het imple-
mentatietraject verloopt prima. Als wij tegen bepaalde zaken 
oplopen of vragen hebben, worden wij direct geholpen. Ook 

Ingenieursbureau Van der Waal & Partners hanteert “NLCS, tenzij….”

De Nederlandse CAD Standaard (NLCS) wordt steeds meer gemeengoed binnen de Civiele Techniek. 

Recentelijk stapte ook ingenieursbureau Van der Waal & Partners uit Naaldwijk over op de NLCS. 

Binnen de organisatie werd aanvankelijk getwijfeld over de meerwaarde ervan, maar na een aantal 

projecten ‘nieuwe stijl’ reageren ontwerpers én opdrachtgevers positief op de overstap.

Maarten van Ameijden (links) 
en Erik van der Aart maakten 
zich hard voor de NLCS 
binnen hun organisatie
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Ingenieursbureau Van der Waal & Partners hanteert “NLCS, tenzij….”
Door: Van der Waal & Partners

naar onze wensen wordt goed geluisterd. Hiermee leveren we een bijdrage 
aan de verdere ontwikkeling van Organize NLCS en ook de NLCS in het 
algemeen. We hebben het volste vertrouwen dat, ook nu Para_Graph is 
overgenomen door Scanopy, de goede samenwerking in de toekomst gehand-
haafd wordt.” Toch blijft Van Ameijde ook kritisch: “Ik vind het jammer dat 
Bentley niet of nauwelijks aandacht heeft voor de Nederlandse markt. Zij 
hebben er bewust voor gekozen om de ontwikkeling van de NLCS volle-
dig bij marktpartijen te laten. Ik ben van mening dat Bentley hier juist een 
centrale en coördinerende rol in kan spelen. Jaarlijkse betaal je als bedrijf een 
fors bedrag aan Bentley en hier zien de gebruikers naar mijn idee te weinig 
van terug. De Nederlandse markt is misschien niet zo groot, maar moet wel 
belangrijk zijn voor Bentley.” *

Positieve reacties

Van Ameijde is inmiddels blij met de overgang en voorziet een positieve ont-
wikkeling voor de toekomst: “Ik verwacht dat de NLCS binnen enkele jaren 
door vrijwel iedereen in onze sector zal worden toegepast. Natuurlijk had de 
overgang naar de nieuwe standaard in het begin wat voeten in de aarde, maar 
nu al plukken wij de vruchten ervan. In principe gebruiken we bij alle nieuwe 
projecten direct vanaf het begin Organize NLCS. We hanteren intern het 
motto ‘NLCS, tenzij…’. Uitzonderingen zijn natuurlijk altijd mogelijk, mits 
er een goede reden voor is.” Van Ameijde vervolgt lachend: “Een opdrachtge-
ver moet van goede huizen komen om ons op andere gedachten te brengen. 
Het gebruik van de NLCS is immers ook in zijn belang!” Ook Van der 
Aart kan zich hier prima in vinden. “De investering die we als bedrijf hierin 
gedaan hebben, gooi je natuurlijk niet zomaar overboord. Op projectniveau 
zie je nu al dat zaken door het gebruiken van Organize NLCS efficiënter 
worden uitgevoerd en de eerste reacties van onze opdrachtgevers zijn positief. 
Ook binnen de NLCS kunnen onze ontwerpers dus uitblinken in kwaliteit. 
De eigen huisstijl is dan wel komen te vervallen, maar de herkenbaarheid 
van een échte Van der Waal & Partners-tekening is nog steeds ons doel. De 
NLCS biedt ons hierin voldoende vrijheden.”

W&P ALGEMEEN
Van der Waal & Partners uit Naaldwijk is een ingenieurs-
bureau met veertig jaar ervaring op civieltechnisch gebied. 
In opdracht van uiteenlopende publieke en private partijen 
werken zo’n 50 medewerkers dagelijks aan een totaalpakket 
van diensten op het gebied van Infrastructuur, Gebiedsont-
wikkeling en Beheer & Onderhoud. Ook het verzorgen van 
project- en tendermanagement voor opdrachtgevers én aan-
nemers behoort tot de dagelijkse werkzaamheden van het 
bureau. Naast de inbreng van eigen specialisten werkt Van 
der Waal & Partners ook nauw samen met andere partners 
in de keten. Altijd met een heldere focus op het creëren van 
meerwaarde voor onze opdrachtgevers. 

Meer info:  www.vanderwaal-partners.nl 
of volg ons op Twitter: @VdWaalPartners.

* Reactie Bentley: Bentley heeft er bewust voor gekozen specifieke 
lokale oplossingen zoals bijvoorbeeld NLCS aan de lokale 
marktpartijen over te laten. Bentley is echter wel degelijk nauw 
betrokken bij lokale initiatieven, zoals o.a. de 3D SIG, CB-NL, Infra-
IFC ontwikkelingen en het gebruik van PDOK en AHN2 data in 
Bentley Map.

Maarten van Ameijden (links) 
en Erik van der Aart maakten 
zich hard voor de NLCS 
binnen hun organisatie

Hondenbot rotonde afrit 7 A20, Maasland Voorbeeld van turborotonde in NLCS
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Gebruik van AHN2 in Bentley 
Descartes en MicroStation

Vanaf 6 maart 2014 is het Actueel Hoogte-

bestand Nederland voor iedereen vrij toe-

gankelijk via PDOK. Eerder was al het AHN1 

als 25 meter raster via PDOK beschikbaar, nu 

zijn de AHN2 rasters én de puntenwolken en 

alle overige AHN1 bestanden open data.

Er zit een schat aan data in de PDOK, 
informatie over hoogtes is hier een 
prachtig voorbeeld van. Eenmalig 
inwinning , meervoudig gebruik - Alle 
hoogte data van heel NL is beschik-
baar, en het is nog gratis ook!!! Allerlei 
personen en afdelingen binnen een 
gemeente kunnen hier hun voordeel 
mee doen. Hironder enkele voorbeel-
den waarom je de hoogte data in je 
Bentley omgeving zou willen halen:

•  In kaart brengen van de bestaande 
situatie buiten zonder landme-
ters op pad te hoeven sturen
•  Creëren van terreinmodel voor 
stedebouwkundige ontwerpen. 
Schaduw/ zon analyses, zichtlijnen
•  Beleidsmedewerkers in ri-
olering/ water/ milieu krijgen 
snel en eenvoudig inzicht in 
de hoogte van het terrein
•  Voor civiel: ook nuttig als je in 
2D werkt (hoogtemaatjes in je 
tekening). Als je in 3D werkt kun 
jehet gebruiken om de bestaande 
situatie in kaart te brenegn
•  Geo/ GIS: analyses en kaar-
ten maken (thematische kaarten 
met kleuren of hoogtelijnen)
•  Basis voor een 3D stadsmodel

MicroStation is al vanaf de eerste 
versie volledig 3D. AHN data kan dan 
ook gebruikt worden in MicroStation 
(als puntenwolk) maar om meer met 
de data te kunnen is Bentley Descartes 
nodig. Descartes is beschikbaar als een 
layered applicatie op MicroStation (alle 
functionaliteit van MicroStation is dus 
beschikbaar) en PowerCivil. Tevens is 

de funcitonaliteit van Descartes be-
schikbaar in Bentley Map Enterprise.

AHN2 data

AHN2 is beschikbaar via PDOK 
(www.pdok.nl). De data wordt 
aangeboden via een bladinde-
ling van 5 km x 6.25 km. Gebruik 
de WMS of de PDOK Kaartvie-
wer om te bepalen welk bladen 
gedownload dient te worden.

De volgende AHN2 data kan 
worden gedownload:

•  AHN2 0,5 meter maai-
veld raster, opgevuld
•  AHN2 0,5 meter maai-
veldraster, niet opgevuld
•  AHN2 0,5 meter ruw raster
•  AHN2 5 meter maaiveldraster
•  AHN2 gefilterde puntenwolk
•  AHN2 uitgefilterde puntenwolk

Tevens zijn WMS en WFS services be-
schikbaar. (voor gebruik van WMS en 
WFS zie het artikel in de MicroVisie 
15-2 (zomer 2013) of de Bentley blog)

WMS

De volgende layers worden 
aangeboden via WMS.

•  Ahn2_0.5m_geinterpoleerd
•  Ahn2_0.5m_niet_geinterpoleerd
•  Ahn2_0.5m_ruw
•  Ahn2_5m
•  Ahn2_bladindex

Via getlegend kan de legenda van 
desbetreffende layer bekeken worden.
De url naar de WMS server is
http://geodata.nationaalgeore-
gister.nl/ahn2/wms?service=w
ms&request=getcapabilities

Raster data

De raster bestanden zijn digi-
tale hoogtebestanden (in de Bentley 
producten: DEM (Digital Elevation 
Models) en zijn te koppelen via de 
Raster Manager van Descartes. Door 

de tiff bestanden te koppelen als een 
Raster Grid (File > Attach Raster 
Grid) is het mogelijk om verschil-
lende display styles te kiezen zoals 
Elevation / Slope / Aspect / Intenisity.

In de Raster Manager.
•  Attach Raster Grid > Raster.
•  Selecteer het bestand.

Er zijn verschillende weer-
gaves in te stellen zoals

•  Elevation
•  Slope
•  Ascpect
•  Intensity

Het instellen gaat via het selecteren 
van de raster file in de Map Manager 
en dan rechtermuis Thematic Dis-
play > juiste weergave selecteren.

Het instellen gaat via het selecteren 
van de raster file in de Map Mana-
ger en dan rechtermuis Thematic 
Set. Selecteer daarna juiste Style 
om de symbology aan te passen.
Puntenwolken

Er worden 2 types puntenwolken 
aangeboden. Gefilterd en uitgefilterd. 
De gefilterde puntenwolk is een maai-
veldbestand, waarbij alle niet-maaiveld 
objecten (bomen, gebouwen, bruggen 
en andere objecten) uit de puntenwolk 
zijn verwijderd De uitgefilterde pun-

Het bestand is nu gekoppeld.

Het aanpassen van de symbology kan via Thematic Set.
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Door: Marc Rietman, Bentley Systems 

tenwolk is een niet-maaiveldbestand, 
het bevat alle niet-maaiveld objecten 
(bomen, gebouwen, bruggen en andere 
objecten) die uit de originele pun-
tenwolk zijn verwijderd. Door de 2 
puntenwolken samen te voegen kan 
een ruwe puntenwolk worden verkre-
gen, waarbij naast het maaiveld en de 
niet-maaiveldobjecten samenkomen.

De puntenwolken worden aangeleverd 
als een LAZ file (een gecomprimeerde 
LAS file, ofwel LASzip). LAS is stan-
daard binair formaat om LiDAR data 
op te slaan en uit te wisselen. Door de 
compressie toe te passen wordt de ori-
ginele LAS file gereduceerd tot ca. 10% 
waarbij geen kwaliteitsverlies optreedt.
De LAZ bestanden dienen te wor-
den omgezet naar een Bentley 
Pointools formaat (.pod). Dit kan 
met een gratis tool Bentley Poin-
tools PODcreator. Met deze tool 
is het ook mogelijk om bestanden 
samen te voegen en uit te filteren.

Omzetten LAZ bestanden.

Het omzetten van LAZ bestan-
den naar .pod kan met Bent-
ley Pointools POD creater.

Deze gratis tool is te downloa-
den via http://www.bentley.
com/en-US/Free+Software/
Bentley+Pointools+PODcreator.htm
Werkwijze:

•  Start Pointools POD creater
•  Selecteer Add Files en selecteer 
de te converteren LAZ bestanden
•  Geeft Export Filename op. (incl 
path). De bestanden krijgen de 
Filename_<LAZname>.pod.
•  Export options op POD per file 
(voor het samenvoegen van LAZ 
bestanden selecteer POD per batch)
•  Selecteer Create POD om 
de conversie te starten

Omdat de data een grote intensiteit 
heeft is het in veel gevallen (bv om 
hoogtematen of hoogtelijnen weer te 
geven) voldoende om minder pun-
ten op te nemen in de .pod file. Dit 
kan door een filter aan te leggen.
In de POD-
Creator zet 
dan de optie 
Uniform Filter 
aan en geef 
een spacing 
op (bv 5m)

De aangemaakte POD bestanden 
zijn te open in de Point Cloud tool in 
MicroStation en Descartes. Descar-
tes bied meer functionaliteit dan de 
standaard tool in MicroStation. Oa 
3D line following, Snap, Draping, 
Clash Detection en nog veel meer.

Scalable Terrain Modellen

Een andere manier om de POD 
bestanden te gebruiken is via ver-
schaalbare terrein modellen Sca-
lable Terrain Models (STM).
Scalable Terrain Models kunnen 
gebruikt worden om grote Terrein 
modellen m.b.v. een multi-resolution 
technogology weer te geven. Deze 
technology is vergelijkbaar met de 
techniek die gebruikt wordt voor 
Raster en PointCloud data. 
Door te gebruik te maken van 
Scalable terrein modellen kunnen 
grotere gebieden worden ontslo-
ten dan via een Terrein model.
Een STM bestaat uit een meer-
dere bestanden. De STM wordt 
opgeslagen buiten de .dgn file.

De POD bestanden worden dus 
gebruikt in de STM. Het is mo-
gelijk om meerdere POD bestan-
den te gebruiken in één STM.

Aanmaken Scalable Terrain Model

De werkwijze voor het aanma-

ken van een STM is als volgt:
•  Open een 3D dgn
•  Start Scalable Terrain Model 
(File > Scalable Terrain Model)

•  Maak een nieuwe STM aan op 
een bekende locatie (File > New)
•  Pas evt. de 
instellingen 
aan. (is later 
aan te passen)
•  De STM Elevation Sour-
ce Editor verschijnt.

•  Selecteer Add Elevation points 
en Point Files en voeg de .pod toe. 
(voor gefilterde .pod bestanden 
is het ook mogelijk om meerdere 

pod bestanden 
samen te voegen 
tot één STM)

•  Druk op Generate voor het aanma-

ken van de Scalable Terrain Model

Gebruik van een Scalable Terrain 
Model. 

Wanneer het Scalable Terrain Mo-
del is aangemaakt kan deze op 
verschillende manieren gebruikt 
worden in Bentley Descartes.
Enkele toepassingen zijn:

•  Thematische weergave van hoogte
•  Thematische weer-
gave van hellingshoek
•  Hoogtelijnen kaart
•  Hoogtematen weergeven.
•  Draperen van vector lijnen
•  Draperen van raster
•  Export naar Terrein Mo-
del voor civiel ontwerp
•  Combineren met 3D ontwerp
•  Aanmaken LOD0 (CityGml)
•  Aanmaken LOD1 en LOD2 
(handmatig of met TerraSolid)
•  Analyses (Zicht analyse, 
zon/schaduw analyse)
 o  Bv bij verkeerssituaties

•  Gebruik in Civiele Ont-
werp / beheer
 o  Inzicht in hoeveel-
heden, beter budgetteren

Het aanpassen van de symbology kan via Thematic Set.
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Draperen van raster over STM

Rasters kunnen over STM’s heen gedrapeerd worden.

De werkwijze is als volgt:
•  In een 3D dgn koppel de STM 
(File > Attach in STM Menu).
•  Attach de de drapen raster-
file in de Raster Manager.
•  Selecteer Set Draping in STM menu

•  Selecteer de te drapen Ras-
ter en Move of Copy the file

•  De Raster is nu gedrappeerd
•  In STM menu selecteer Dis-
play Draped Rasters

•  In View Attributes selec-
teer de juiste Display Style en pas 
de Global Brightness aan.

Hoogtelijnen.

Het is mogelijk om een hoog-
telijnen kaart aan te maken
De werkwijze is als volgt:

•  In een 3D dgn koppel de STM 
(File > Attach in STM Menu).
•  In het STM menu selec-
teer Display Contours.

•  In het STM menu de-
selecteer Display Triangles

•   Via Element Informatie is het moge-
lijk om Symbology ed. Aan te passen

Via Edit > Extract Contours is 
het mogelijk om contouren te 
converteren naar vector elementen.
Voor overige toepassin-
gen zie de handleiding.

Nederlandse Bentley Community

Op de Nederlandse Bentley 
Community kan een uitgebreide 
handleiding over het gebruik 
van AHN2 worden gedownload. 
Tevens kan hier een link wor-
den gevonden naar het webinair 
van 22 april waarbij het gebruik 
van AHN2 wordt behandeld.
http://communities.bentley.com/
communities/user_communities/
bentley_general_nl/default.aspx
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Nieuwe tijden brengen nieuwe begrippen en buzz-words. 
Verschuivingen in hardware en software platformen, 
methoden voor ontwerp en realisatie van software, de 
cloud, SaaS...zowel in ons zakelijk als persoonlijk gebruik 
van IT is er heel veel veranderd in de afgelopen 10 tot 20 
jaar. En dit alles voornamelijk om tegemoet te komen aan 
de snel wijzigende eisen en wensen van IT-gebruikers.

Niet alleen verandert veel, de veranderingen komen 
ook steeds sneller. Nieuwe projecten, op nieuwe 
locaties, in samenwerkingsverbanden die bij elk project 
wijzigen...de lijst groeit. In al deze gevallen kan IT 
hoofdbrekens (en –pijn) bezorgen door vertragingen, 
toenemende kosten, het noodzakelijk maken van 
nieuwe aanschaffen, installatie en beheer, een 
beveiligde locatie voor de data en ga zo maar door. 

Vertragingen verkleinen of voorkomen

Met Bentley’s MANAGEservices is het mogelijk vertragingen 
op dit vlak te voorkomen of in elk geval te verkleinen. 
Bentley’s producten (inclusief ProjectWise) kunnen in de 
cloud beschikbaar gesteld worden, in combinatie met 
on-site voorzieningen zoals caching servers. En dit alles 
binnen een week, wat het mogelijk maakt om snel en 
adequaat te reageren op wijzigende omstandigheden.
Niet onbelangrijk hierin is de meer recente wens 
om de totale kosten van een IT-oplossing van een 
primair investeringsmodel (CAPEX) te wijzigen naar 
een model waarbij deze kosten genomen worden 
gedurende het gebruik van het systeem (OPEX).

Flexibiliteit en vrijheden

Bentley bood in haar licentiemodellen altijd al de nodige 
flexibiliteit en vrijheden, maar heeft daaraan recentelijk 
het concept van MANAGEservices toegevoegd. 

Hierbij wordt het traditionele aanschaffen van software 
en hardware voordat tot productie kan worden 
overgegaan, alsmede de kosten voor beheren van het 
system, vervangen door een subscription model.

Laat ik ook meteen een mogelijk misverstand uit de 
weg ruimen: het bovenstaande betekent niet dat er 
geen investering vooraf meer zal zijn. Om te komen van 
een initiële lijst met eisen/wensen tot een productief 
systeem zullen met name voor complexere systemen 
nog steeds kosten gemaakt worden voor detailontwerp, 
maatwerkaanpassingen, configuratie, testen en opleiden. 

De kosten voor aanschaf en een deel van de kosten 
voor installatie worden echter niet in een keer aan 
het begin van het project in rekening gebracht, maar 
verspreid over de periode waarin het systeem wordt 
gebruikt. Naast het directe financiële voordeel, biedt 
Bentley als onderdeel van MANAGEservices ook de 
upgrades aan naar nieuwere versies van de producten.

Tegemoetkoming aan eisen van de gebruiker

Bentley is in staat via een combinatie van Professional 
Services, MANAGEservices en LEARNservices en met 
gebruikmaking van best practices, snel een oplossing te 
leveren die tegemoet komt aan de gebruikerseisen, door 
Bentley geïnstalleerd op een door Bentley voorbereide 
infrastructuur die ook door Bentley wordt beheerd. 
Parallel hieraan worden de eindgebruikers opgeleid. 
Hiermee kan de tijd tussen opdrachtverlening en go-live 
eerder in weken dan in maanden gemeten worden.
Bentley maakt graag tijd beschikbaar om samen de situatie 
ter plekke te analyseren en de beste optie te kiezen.

Harrie.vanMullekom@bentley.com

Bentley’s MANAGEservices

Harrie van Mullekom Practice Leader Bentley ALIM - EMEA
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COPYRIGHTS
Het auteursrecht op deze uitgave en op de daarin 
verschenen artikelen wordt door de uitgever voorbe-
houden. Het verlenen van toestemming tot publicatie 
in deze uitgave houdt in dat de auteur de uitgever, 
met uitsluiting van ieder ander, onherroepelijk mach-
tigt de bij of krachtens de Auteurswet door derden 
verschuldigde vergoedingen voor kopiëren te innen 
en dat de auteur alle overige rechten overdraagt 
aan de uitgever. Niets uit deze uitgave mag worden 
overgenomen, vermenigvuldigd of gekopieerd zonder 
uitdrukkelijke toestemming van de uitgever. De 
uitgever stelt zich niet aansprakelijk voor eventuele 
onjuistheden welke in de uitgave mochten voorkomen.

Natuurlijk, in veel organisaties wordt geld met de hand op 
de knip bewuster uitgegeven of is er zelfs helemaal geen 
budget meer. Processen moeten efficiënter en dezelfde bak 
met werk moet in veel situaties ook nog eens met minder 
collega’s uitgevoerd worden. Daarnaast hebben we te maken 
met standaarden die doorgevoerd moeten worden, maar ook 
volgen en ‘eigen’ maken van trends en ontwikkelingen zoals 
alle Social Media om ons heen. Voor de één een zegen, voor de 
ander nog meer ballast om dagelijks bij te (moeten) houden. 

Velen onder ons Twitteren, Facebooken en WhatsAppen zich 
momenteel nog steeds helemaal suf. Er is geen (bij)houden aan en 
dat kan voor onrust zorgen. Bij mij ook. Op een gegeven moment 
kwam zelfs de gedachte bij me op een aantal accounts volledig 
overboord te gooien. Dat heb ik niet gedaan, want het brengt ook 
veel goede en nuttige informatie met zich mee. Het heeft mij wel 
geholpen om op een moment de bezem bewust te halen door de 
hoeveelheid ‘vrienden, contacten, volgers en groepen’. Dit geeft 
overzicht en serveert de gefilterde informatie van wie of waarvan je 
wèl op de hoogte gehouden wilt blijven worden. 

Vreemd genoeg ontving ik vóór, maar nu ook nà mijn 
schoonmaakactie helemaal niet zo veel (nieuws)berichten 
over Bentley. Terwijl die er wel zouden moeten zijn. Ook 
niet op internetflora van TMC, LinkedIN of op één van de 
Communities op de Bentley website. Dit zijn toch aangewezen 
plekken waar naast het delen van kennis en informatie 
juist ‘open’ gecommuniceerd zou moeten worden over 
bijvoorbeeld technische onvolkomenheden, wensen voor 
verbeterde processtappen of functionaliteit. Maar ook over 
ontwikkelingen, keuzes en koers van de leverancier waarvan 
we zeggen dat we er elke keer weer door overvallen worden. 
Door er gezamenlijk over te praten en discussies breder te 
trekken kunnen we proberen ruis op de communicatielijn 
te verminderen. Het is toch aan de gebruikers de taak en 
zelfs de verantwoordelijkheid om een gezonde relatie en 
interactie met de leverancier en onderling te onderhouden. 
Niet achterover leunen dus, communiceer. Gebruiken die 
internetmogelijkheden!

Het is ook lastig om afspraken na te komen en te doen 
wat je zegt of beloofd hebt. Iedereen heeft daar in 

meer of mindere mate mee te maken. Daarom is het 
goed om elkaar hier scherp in te houden en op aan 
te (kunnen) spreken als dat nodig is. Echt waar, ik 
ben ervan overtuigd, het helpt om aan te geven wat 

wel of niet goed is of waar zaken beter, anders, 
en werkprocessen slimmer en efficiënter 
kunnen. Alleen dan kunnen signalen gezien, 
gehoord en opgepakt worden. Daardoor 

zien ook Bentley Partners en andere gelieerde 
bedrijven dat er kansen liggen op het gebied van 
doorontwikkeling van toepassingen op mobile apps 

van Bentley, nieuwe vormen van opleiding en training, 
maar zeker ook efficiënte tools voor het fundament wat 
MicroStation en Bentley Map in mijn ogen is voor veel 

lezers van dit blad. Dus, blijf denken in mogelijkheden en 
kansen, maar bovenal blijf positief… 
ßstemuithetveld@tmc-nederland.nl
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NedBGT! Dé oplossing 
voor bronhouders die  
kiezen voor kwaliteit!
BGT  Als  het  gaat  om  de  invoering  van  Basisregistratie  Grootschalige Topografie  (BGT),  kunt  u  niet 

vroeg genoeg beginnen met de voor bereidingen. Er komt nogal wat bij kijken om bestaande informatie 

te  laten  voldoen  aan  de  eisen  van  de  BGT.  NedGraphics  heeft  al  menig  klant  geholpen  in  de 

voorbereidingsfase.

NedBGT,  dé BGT oplossing, is ontwikkeld om u te ondersteunen in alle fasen van de totstandkoming 

van de BGT. Zowel  in de  transitiefase als  in de beheerfase, waarbij ook de datadistributie optimaal 

wordt ondersteund.

Kwaliteit  Een investering in de juiste software leidt tot betere dienstverlening, betere samenwerking 

en  kostenbesparing.  Dat  is  het  voordeel  van  kiezen  voor  kwaliteit.  Maakt  u  gebruik  van  onze 

adviesdiensten (projectleiding, quick scan, conformiteitstoets, plan van aanpak, masterclass) dan heeft 

u alle zekerheid dat u een rendabele en duurzame investering doet. Bel of mail ons voor een nadere 

kennismaking!

Telefoon (0347) 32 96 00

info@nedgraphics.nl, www.nedgraphics.nl
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